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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required 
to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the 
use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

Allen-Bradley, Rockwell Software, Rockwell Automation, PlantPAx, FactoryTalk, RSLinx, RSLogix, RSNetWorx, and ControlFLASH are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).



Summary of Changes

This manual contains new and updated information. Changes throughout this 
revision are marked by change bars, as shown to the right of this paragraph.

New and Updated 
Information

This table contains the changes made in this revision.

Topic Page

Changed System Release number to 3.00.1 Front Cover

Preface:
In the Virtual Template Catalog Numbers table, changed ‘9528-APPHISTENE’ 
to ‘9528-APPHISENE’
Made the following changes to the System and Software Requirements table:
– updated FactoryTalk View SE Studio and Client software from version 

7.00.00 to 8.00.00 (CPR9 SR7)
– updated FactoryTalk Services Platform software from version 2.60.00 to 

2.70.00 (CPR9 SR7)
– update RSLinx Classic OEM software from version 2.59.00 to 

2.59.01 (CPR9 SR5)
– updated RSLinx Enterprise software from version 5.60.00 to 

5.70.00 (CPR9 SR7)
– updated FactoryTalk Activation software from version 3.60.00 to 

3.62.01 (CPR9 SR6)
– updated RSLogix 5000 Professional software from versions 19.00.00 and 

20.00.00 to 19.01.00 (CPR9 SR3) and 20.01.00 (CPR9 SR5)
– updated Adobe Acrobat Reader software from version 10.01 to 11.0.03
– updated VMware tools from version 8.3.7 to 9.40.1280544

9

10

Chapter 1: 
Replaced various images to match screens changed or combined (Datastore 
and Disk Format) by vSphere Client 5.5.0.
Added Important note concerning differing images and versions of vSphere 
Client.
Added table describing storage formats.
Added step to clear 'Power on after deployment' checkbox.
Added Important note concerning time for process to finish.
Added step to expand the organizer tree.
Added step to clear the 'Power on this virtual machine after creation' 
checkbox.
Added step to review task status.

13

19, 25, 30
21
21, 26, 32
27
31

32

Chapter 2:
Added Important note concerning differing images and versions of vSphere 
Client.
Added Important note concerning screen remaining black for several minutes.
Added steps 9 through 11.
Added steps 14 and 15.
Added new section: Microsoft SQL Server 2008 Express Account Information.

35

37
38
55
57

Chapter 3:
Added Important note concerning screen remaining black for several minutes.
Added new section: Microsoft SQL Server 2008 Express Account Information.

61
69

Chapter 4:
Added Important note and text in case the Browse button is inactive.
Added Important note concerning screen remaining black for several minutes.
Added steps 9 through 11.
Added Important note concerning pressing proper keys to log in.

66
73
75
82

Chapter 5: Added Important note concerning pressing proper keys to log in. 102
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Preface

This manual for version 3.00.10 describes how to use virtual image templates for 
setting up virtual machines. Virtual machines are independent operating 
environments that use virtual resources. As the manufacturing industry embraces 
the virtual infrastructure, the use of the PlantPAx® Virtual Image Templates 
provides reduced complexity and increased efficiency of system deployment.

Virtual image templates are provided for the following PlantPAx
system elements:

• Process Automation System Server (PASS)
• Engineering Workstation (EWS)
• Operator Workstation (OWS)
• Application Server OWS (AppServ-OWS)
• Application Server Historian (AppServ-Hist)

The templates are delivered as an Open 
Virtual Format (OVF) file, which lets you 
use any virtualization platform for 
deployment. The guidelines contained in 
this manual are for setup and deployment 
of the templates in a VMware vSphere 
environment. 

The OVF templates required for the 
corresponding system element are 
included and pre-installed, but not 
activated (see figure on right). This helps 
to minimize the set-up and configuration 
time required to deploy the PlantPAx 
system in a traditional IT environment. To 
activate each system element, you can 
purchase a separate activation license. 

IMPORTANT The images that appear in this document are for example only and can be 
different than your vSphere environment.
Rockwell Automation Publication 9528-UM001D-EN-P - March 2015 7



Preface
Before You Begin You need the following items during the setup and configuration of the
virtual templates:

• PlantPAx Virtual Images Templates USB drive to access the template files
• Microsoft Volume License keys:

– PASS template requires a Microsoft Volume License Key for
Windows Server 2008 R2 SP1 operating system

– EWS and OWS workstation templates each require a
Microsoft Volume License for Windows 7 Professional SP1
operating system

– Application Server OWS (AppServ-OWS) template requires a 
Microsoft Volume License Key for Windows Server 2008 R2 SP1 
operating system

– Application Server Historian template requires a Microsoft Volume 
License Key for Windows Server 2008 R2 SP1 operating system

• VMware vSphere Client software with access to the vCenter server and 
appropriate credentials for creating and deploying virtual machines

• FactoryTalk® Activation Certificates that you purchased with the templates 
that contain serial numbers and product keys

See Virtual Template Catalog Numbers on page 9.

• Domain servers must be installed and available if you use a Domain 
(recommended).

Microsoft Software Licensing

The PlantPAx templates were designed for use with Microsoft Volume Licensing 
only. Each template contains a Full Packaged Product (FPP) license and must be 
converted to a Volume License within 90 days. Retail Microsoft licensing is
not supported.

To activate the templates, contact your Microsoft software representative to 
convert the FPP license or to obtain a Microsoft Volume License Agreement.

TIP Remote Desktop Services has its own method, separate from licensing 
for the Windows Server 2008 R2 family of operating systems, for 
licensing clients that log on to Remote Desktop Services servers. 
Therefore, AppServ-OWS Remote Desktop Connections must receive a 
valid license issued by a Remote Desktop Licensing Server before they 
can log on to a Remote Desktop Session Host or Connection Broker.

IMPORTANT If you already own individual product activations, these activations 
also can be used to activate the virtual image templates.
8 Rockwell Automation Publication 9528-UM001D-EN-P - March 2015



Preface
Virtual Template Catalog 
Numbers

This table lists the product catalog numbers for the virtual templates.

Rockwell Automation 
Software License Catalog 
Numbers

This table lists the catalog numbers for Rockwell Automation software licenses 
for PASS, EWS, and OWS.

Cat. No.(1)

(1) English version is listed. Different languages are available by contacting your local Allen-Bradley® distributor or Rockwell 
Automation sales representative.

Description

9528-PAXVTENE USB device that contains three virtual image templates (PASS, EWS, and OWS). Each 
template contains a Microsoft Windows operating system, with all required Rockwell 
Automation software pre-installed but not activated. A Microsoft full packaged product 
license is included.

9528-APPOWSENE USB device that contains the virtual image template for AppServ-OWS. The template 
contains a Microsoft Windows operating system, with all required Rockwell Automation 
software pre-installed but not activated. A Microsoft full-packaged product license is 
included.
IMPORTANT: Each client connecting to AppServ-OWS must have a valid client license.

9528-APPHISENE USB device that contains the virtual image template for AppServ-Hist. The template 
contains a Microsoft Windows operating system, with all required Rockwell Automation 
software pre-installed but not activated. A Microsoft full-packaged product license is 
included.
IMPORTANT: There are no separate vTemplate Serial Number/Product IDs for licensing 
Application Server Historian. You must use individual Historian product licenses.

Cat. No.(1)

(1) English version is listed. Different languages are available by contacting your local Allen-Bradley distributor or Rockwell 
Automation sales representative.

Description

9528-PASS100ENE
9528-PASS250ENE
9528-PASSUNLENE

100-display license for the PASS server.
250-display license for the PASS server.
Unlimited display license for the PASS server.

9528-EWSLICENE Software activation license for the EWS.

9528-OWSLICENE Software activation license for the OWS and AppServ-OWS.
Rockwell Automation Publication 9528-UM001D-EN-P - March 2015 9



Preface
Build Details This table lists the system build details for the PlantPAx system virtual
image templates. The virtual image templates are based on VMware Virtual 
Hardware, version 7.

Table 1 - System and Software Requirements

Element Category Description

EWS Operating system Windows 7 Professional SP1 64-bit operating system 

Rockwell Automation software • FactoryTalk View SE Studio and Client software, version 8.00.00 (CPR9 SR7)
• FactoryTalk Services Platform

– FactoryTalk Services Platform software, version 2.70.00 (CPR9 SR7)
– RSLinx® Classic OEM software, version 2.59.01 (CPR9 SR5)
– RSLinx Enterprise software, version 5.70.00 (CPR9 SR7)

• FactoryTalk Activation software, version 3.62.01 (CPR9 SR6)
• RSLogix™ 5000 Professional software, versions 19.01.00 (CPR9 SR3), 20.01.00 (CPR9 SR5)

– PID Auto Tune software
– All firmware toolkits (no Motion)
– RSNetWorx™ for DeviceNet software
– RSNetWorx for ControlNet software
– RSNetWorx for Ethernet software
– RSLogix Architect software
– ControlFLASH™ software
– RSLogix 5000 Fuzzy Designer software (activated separately)
– RSLogix Emulate 5000 software

Additional third-party software • Adobe Acrobat Reader software, version 11.0.03
• Control Station LOOP-PRO TUNER software, version 1.5.0 

(Allen-Bradley edition) (activated separately)
• Microsoft Internet Explorer software, version 8
• VMware tools, version 9.40.1280544

OWS Operating system Windows 7 Professional SP1 64-bit operating system 

Rockwell Automation software • FactoryTalk View SE Client software, version 8.00.00 (CPR9 SR7)
• FactoryTalk Services Platform software, version 2.70.00 (CPR9 SR7)
• FactoryTalk Activation software, version 3.62.01 (CPR9 SR6)

Additional third-party software • Adobe Acrobat Reader software, version 11.03
• Microsoft Internet Explorer software, version 8
• VMWare tools, version 9.40.1280544

PASS Operating system Windows 2008 R2 SP1 64-bit operating system 

Rockwell Automation software • FactoryTalk View SE software, version 8.00.00 (CPR9 SR7)
• FactoryTalk View SE Studio software, version 8.00.00 (CPR9 SR7)
• FactoryTalk Services Platform

– FactoryTalk Services Platform software, version 2.70.00 (CPR9 SR7)
– RSLinx Enterprise software, version 5.70.00 (CPR9 SR7)
– FactoryTalk Activation software, version 3.62.01 (CPR9 SR6)

• Alarms and Events server software, version 2.60.00

Additional third-party software • Adobe Acrobat Reader software, version 11.0.03
• Microsoft Internet Explorer software, version 8
• VMware tools, version 9.40.1280544

Application Server 
OWS

Operating system Windows 2008 R2 SP1 64-bit operating system 

Rockwell Automation software • FactoryTalk View SE Client software, version 7.00.00
• FactoryTalk Services Platform software, version 2.60.00
• FactoryTalk Activation software, version 3.60.00

Additional third-party software • Adobe Acrobat Reader software, version 10.01
• Microsoft Internet Explorer software, version 8
• VMware tools, version 8.3.7

FactoryTalk Historian 
Application Server

Operating system Windows 2008 R2 SP1 64-bit operating system 

Rockwell Automation software FactoryTalk Historian SE software, version 4.0

Additional third-party software • Adobe Acrobat Reader software, version 10.01
• Microsoft Internet Explorer software, version 8
• Microsoft SQL Server 2008 R2 Express
• VMware tools, version 8.3.7
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Preface
For More Information These documents contain information about related products from 
Rockwell Automation.

You can view or download publications at
http://www.rockwellautomation.com/literature/. To order paper copies of 
technical documentation, contact your local Allen-Bradley distributor or 
Rockwell Automation sales representative.

Resource Description

PlantPAx Process Automation System Reference Manual, 
publication PROCES-RM001

Details the application rules for implementing a 
PlantPAx system.

PlantPAx Process Automation System Selection Guide, 
publication PROCES-SG001

Provides procurement information for a
PlantPAx system.

Product Certifications website, http://www.ab.com Provides declarations of conformity, certificates, and 
other certification details.

FactoryTalk Historian SE Installation and Configuration 
Guide, publication HSE-IN025

Provides information on how to install, secure, 
configure, use, and troubleshoot 
FactoryTalk Historian SE.

Knowledgebase Answer ID 32715 - Cannot add/change pens 
in trend from SE client on Terminal Server at 
https://rockwellautomation.custhelp.com/app/answers/
detail/a_id/32715
You must have a TechConnect™ license to view this 
document.

Provides details on the problem of adding/changing 
pens in trend from SE client on Terminal Services.

Knowledgebase Answer ID 496679 - FAQ: FactoryTalk 
Historian SE: MDB to AF Preparation Wizard at 
https://rockwellautomation.custhelp.com/app/answers/
detail/a_id/496679 
You must have a TechConnect license to view this document.

Provides information on using the FactoryTalk Historian 
SE MDB to AF Preparation wizard.

Knowledgebase Answer ID 567658 - Using FactoryTalk View 
SE with Windows 2008 R2 Remote Desktop Services - 
Getting Started Whitepaper at 
https://rockwellautomation.custhelp.com/app/answers/
detail/a_id/567658
You must have a TechConnect license to view this document.

Provides information on using FactoryTalk View SE with 
Microsoft Windows 2008 R2 Remote Desktop Services.

Knowledgebase Answer ID 60585 - FactoryTalk Historian SE 
Collective Manager Error - Error Writing Server at
https://rockwellautomation.custhelp.com/app/answers/
detail/a_id/60585 
You must have a TechConnect license to view this document.

Provides information on implementing a collective for 
FactoryTalk SE Historian.
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Chapter 1

Configure the Virtual Image Templates

Virtualization lets you remove the operating system dependency on computer 
hardware and enables you to consolidate workloads by putting multiple virtual 
machines on a single piece of hardware. Each virtual machine is dynamically 
allocated a share of the hardware resources to function like a physical machine. 
The PlantPAx system offers pre-built templates of virtual machines for specific 
server and workstation system elements.

The table outlines the process for creating virtual machines by using the virtual 
image templates. 

Deploy a Virtual Image 
Template for the First Time

Complete these steps to import a virtual image template from the USB drive to 
the Datacenter for the first time. This procedure must be repeated for each 
virtual image template (PASS, EWS, OWS, AppServ-OWS, AppServ-Hist).

1. Click Start and choose All Programs>VMware>VMware vSphere Client.

IMPORTANT You must have VMware vSphere Client software connected to a vCenter server 
to deploy a PlantPAx system virtual image template to the ESXi server.
The images in this section are from VMware vSphere Client 5.5.0. If you are 
using a different version of vSphere Client, the screens you see may be 
different.

Topic Page

Deploy a Virtual Image Template for the First Time 13

Create a Template on Datacenter for Future Deployments 22

Deploy Additional Virtual Machines from Datacenter 27
Rockwell Automation Publication 9528-UM001D-EN-P - March 2015 13



Chapter 1 Configure the Virtual Image Templates
The VMware vSphere Client login dialog box appears.

2. Type information in the login dialog box.

3. Click Login.

4. From the File menu, choose Deploy OVF Template.

Field Description

IP address/Name Type an IP address for the server.
For example: 172.18.27.24

User name Type a user name for the server specified previously.

Password Type the user password.

Use Windows session credentials Clear the checkbox.
14 Rockwell Automation Publication 9528-UM001D-EN-P - March 2015



Configure the Virtual Image Templates Chapter 1
The Deploy OVF Template Wizard appears.

5. Browse to the OVF template.

6. Select the appropriate file and click Open.

The path to the file appears in the Deploy from a file or URL field.

7. Click Next.
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Chapter 1 Configure the Virtual Image Templates
The Deploy OVF Template dialog box shows the OVF Template Details 
(boldfaced in the left column).

8. Review the information in the Product Name (circled in the previous 
figure) field to verify that it is the correct image you want to deploy.

9. Click Next.

IMPORTANT The product name, such as 'PlantPAx PASS Virtual Template v3.00.1', 
and size can vary between virtual images.
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Configure the Virtual Image Templates Chapter 1
The Deploy OVF Template dialog box shows the Name and Location 
section to define for your virtual environment.

10. In the Name box, type a name for your deployed template.

11. In the Inventory Location box, select a location in your Datacenter for the 
deployed template and click Next.

The Deploy OVF Template dialog box shows the Host/Cluster section.
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Chapter 1 Configure the Virtual Image Templates
12. Select the host in the cluster and click Next.

The Deploy OVF Template dialog box shows the Storage section.

13. Select the destination Storage to host the deployed template and 
click Next.
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The Deploy OVF Template dialog box shows the Disk Format section.

14. Select one of the following formats to store the virtual back-up disks:  

15. Click Next.

Format Description

Thick Provision Lazy Zeroed Disk storage is allocated immediately in a default thick format where 
blocks containing older data on the storage device are only cleared 
when the virtual machine writes new data to the disk for the first time.

Thick Provision Eager Zeroed Disk storage is allocated immediately in a default thick format where 
blocks on the physical storage device are formatted with zeros to 
overwrite any older data.

Thin Provision Disk storage is allocated on demand as data is written to virtual disks.
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The Deploy OVF Template dialog box shows the Network Mapping 
section.

16. Map the networks in the Source column to networks in your inventory.

17. Click Next.
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The Deploy OVF Template dialog box shows the Ready to Complete 
section so you can verify the deployment settings. Your information can 
vary from the example dialog box.

18. Clear the 'Power on after deployment' checkbox.

19. Select one of the following to verify settings:
• If information is wrong, click Back to correct the information.
• If the information is correct, click Finish.

The dialog box shows the progress of the template deployment.  

IMPORTANT The template deployment can take 20 minutes or more depending on the size 
of your template.
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When the deployment is finished, a message dialog box appears with 
‘Deployment Completed Successfully’.

20. Click Close.

The name of the new virtual machine appears in the Organizer tree under 
the correct Datacenter, such as PlantPAx vTemplate Library.

21. Select the new virtual machine, and then click the Summary tab to see 
general and resource details for your new machine. 

Create a Template on 
Datacenter for Future 
Deployments

Now that you have deployed the OVF template from the USB drive, this section 
shows how to create a template within the Datacenter for future deployments. 
This new template is no longer in OVF format, but in a format used by VMware.

1. If the VMware vSphere Client is not already open, on a computer with 
VMware vSphere Client software installed click Start and choose 
All Programs>VMware>VMware vSphere Client.

The vSphere Client Window appears.

2. Right-click the template that you want to clone and select 
Template>Clone to Template from the menus that appear.
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The Clone Virtual Machine to Template dialog box shows the Name and 
Location section.

3. In the Template Name box (circled in the previous figure), type a name for 
the cloned template.

4. In the Template Inventory Location box, select a location to store the new 
template and click Next.
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The Clone Virtual Machine to Template dialog box shows the
Host/Cluster section.

5. Select the host in the cluster and click Next.
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The Clone Virtual Machine to Template dialog box shows the
Datastore section.

6. Select one of the following formats from the pull-down menu to store the 
virtual back-up disks:  

7. Select the Datastore to host the cloned template and click Next.

Format Description

Same format as source Use the same format as the original disks.

Thick Provision Lazy Zeroed Disk storage is allocated immediately in a default thick format where 
blocks containing older data on the storage device are only cleared 
when the virtual machine writes new data to the disk for the first time.

Thick Provision Eager Zeroed Disk storage is allocated immediately in a default thick format where 
blocks on the physical storage device are formatted with zeros to 
overwrite any older data.

Thin Provision Disk storage is allocated on demand as data is written to virtual disks.
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The Clone Virtual Machine to Template dialog box shows the
Ready to Clone Virtual Machine to Template section.

8. Select one of the following to verify settings:
• If information is incorrect, click Back to correct the information.
• If the information is correct, click Finish. 

9. You can view the status of the task by finding ‘Clone virtual machine’ in 
Recent Tasks at the bottom of the window. When the status = Completed, 
the cloning is finished. 

IMPORTANT It can take 30 minutes, depending on the size of the hard disk drive, to clone a 
virtual machine to a template.
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Deploy Additional Virtual 
Machines from Datacenter

Now that we have templates on the Datacenter, additional deployments can be 
performed from these new templates. We no longer require the USB drive or 
VMware to convert from the OVF format.

This new template is no longer in OVF format, but in a format used by VMware.

1. If VMware vSphere Client is not already open; on a computer with 
VMware vSphere Client software installed, click Start and choose 
All Programs>VMware>VMware vSphere Client.

The vSphere Client Window appears.

2. Click Home.

3. Click the VMs and Templates icon.

4. Expand the organizer tree.

5. Right-click the cloned template and choose 'Deploy Virtual Machine from
this Template'.
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The Deploy Template dialog box appears with the Name and
Location section.

6. In the Name box (circled in the previous figure), type a name for your 
virtual machine.

7. In the Inventory Location box, select the location of the virtual 
environment in the template and click Next.
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The Deploy Template dialog box shows the Host/Cluster section.

8. Select the host in the cluster and click Next.
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The Deploy Template dialog box shows the Datastore section.

9. Select one of the following formats from the pull-down menu to store the 
virtual back-up disks:  

10. Select the Datastore to host the cloned template.

11. Click Next.

Format Description

Same format as source Use the same format as the original disks.

Thick Provision Lazy Zeroed Disk storage is allocated immediately in a default thick format where 
blocks containing older data on the storage device are only cleared 
when the virtual machine writes new data to the disk for the first time.

Thick Provision Eager Zeroed Disk storage is allocated immediately in a default thick format where 
blocks on the physical storage device are formatted with zeros to 
overwrite any older data.

Thin Provision Disk storage is allocated on demand as data is written to virtual disks.
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The Deploy Template dialog box shows the Guest Customization section.

12. Clear the 'Power on this virtual machine after creation' checkbox.

13. Click one of the following options for the guest operating system that is 
hosting the new virtual machine:
• Do not customize (recommended)
• Customize by using the Customization Wizard
• Customize by using an existing customization specification

14. Click Next.
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The Deploy Template dialog box shows the Ready to Complete section.

15. Clear the Edit virtual hardware (Experimental) checkbox.

16. Select one of the following to verify settings:
• If information is wrong, click Back to correct the information.
• If the information is correct, go to step 17.

17. Click Finish.

18. You can view the status of the task by finding ‘Clone virtual machine’ in 
Recent Tasks at the bottom of the window. When the status = Completed, 
the cloning is finished. 

IMPORTANT The template deployment can take 30 minutes or more depending on the size 
of the virtual machine.
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19. Once the deployment is complete, you can start your virtual machine.

To start your virtual machine, see the respective section:
• Chapter 2, Configure the Process Automation System Server (PASS) 

on page 35
• Chapter 3, Configure the EWS and OWS System Elements on page 59
• Chapter 4, Configure Application Server OWS (Microsoft Remote 

Desktop Services) on page 71
• Chapter 5, Configure Application Server Historian on page 93
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Notes:
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Configure the Process Automation System 
Server (PASS)

This chapter details several procedures for configuring a new Process Automation 
System Server (PASS) virtual machine:

• Setting up Windows Server 2008 for the new instance
• Setting up the Network Adapter
• Setting up FactoryTalk Directory
• Setting up activation files

The FactoryTalk Directory is the information hub that centralizes the settings 
and administration of Rockwell Automation software components across 
multiple computers throughout the PlantPAx system. You must designate a PASS 
server for the FactoryTalk Directory.

The required Rockwell Automation software for the PASS system element 
virtual template is included and pre-installed in the virtual image templates, but 
not activated. To activate each PASS virtual template, you can purchase a single 
activation license for each virtual template instance.

See page 9 for product catalog numbers.

The table includes topics that describe how to configure the PASS template.  

IMPORTANT The images in this section are from VMware vSphere Client 5.5.0. If you are 
using a different version of vSphere Client, the screens you see may be 
different.

IMPORTANT If you already own individual product activations, these activations also can be 
used to activate the virtual image templates.

Topic Page

Before You Begin 36

Configure Microsoft Windows Server 2008 36

Configure Ethernet Network Adapter Settings 49

Configure the FactoryTalk Directory on the PASS 50

Configure the FactoryTalk Activation Server 56

Microsoft SQL Server 2008 Express Account Information 57
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Before You Begin You must deploy your template from the USB drive or from a cloned template to 
perform the following procedures in this chapter. If you need to deploy the 
template, see Chapter 1 on page 13 for details.

Configure Microsoft Windows 
Server 2008

Complete these steps on a virtual machine to initiate the Microsoft Windows 
Server 2008 operating system setup for the PASS server. You set your own 
administration account password, computer name, and file location preference in 
this procedure.

1. If the vSphere Client is not already open, on a computer with VMware 
vSphere Client software installed, click Start and choose All 
Programs>VMware>VMware vSphere Client.

2. In the Organizer tree, click the name of the virtual machine.

3. Click the Console tab.

4. In the Organizer tree, right-click the virtual machine and choose 
Power>Power On.

IMPORTANT During the configuration of the PASS server, you can encounter a User Account 
Control window that asks if you want to allow a program to make changes to 
the computer. Click Yes and continue on.
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The Microsoft Windows Set Up Windows dialog box appears.  

IMPORTANT The screen can remain black for several minutes.

IMPORTANT First, click inside the console to activate the controls for your virtual 
machine.
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5. Choose the appropriate option from the following pull-down menus.

6. Click Next.

The License Agreement appears. This agreement includes
Microsoft Windows, Rockwell Automation Software, and Adobe Reader.

7. Read the license agreement, and then click ‘I accept the license terms’.

8. Click Start.

You will see a screen that says ‘Press CTRL + ALT + DELETE to log on’. 

9. Press CTRL+ALT+INSERT.

The icon for the Administrator account is displayed.

Menu Description

Country or region Choose your country or region, for example,
United States.

Time and currency Choose your time and currency, for example, English 
(United States).

Keyboard layout Choose your keyboard layout, for example, US.

IMPORTANT Even though ‘Press CTRL + ALT + DELETE …’ is displayed on the screen, you 
must press CTRL + ALT + INSERT to access the virtual machine.
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10. Click the Administrator icon.

You will see a message stating 'The user’s password must be changed before 
logging in the first time.' 

11. Click OK.
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The Administrator account dialog box appears so you can change
a password.  

12. Type a password, then verify the entry by typing the same password in the 
second entry field.

13. Click the arrow.

14. Click OK to acknowledge your password has been changed.

IMPORTANT Passwords must meet the following minimum requirements:
• Cannot contain the user's account name or parts of the user's full 

name that exceed two consecutive characters
• Must be at least six characters in length
• Must contain characters from three of the following four 

categories:
– English uppercase characters (A…Z)
– English lowercase characters (a…z)
– Base 10 digits (0…9).
– Non-alphabetic characters (for example, !, $, #, %).
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The virtual image desktop appears.

IMPORTANT The default time zone for Windows Server 2008 is Pacific Time. If you are not in 
the Pacific Time zone, you need to change time zone and update the time.
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Create an Administrator User Account

We suggest that you create an Administrator user account for each user that 
requires administrative privileges. This best practice safeguards server corruption 
by restricting access to the default administrative account, and creates a backup of 
critical system information. Each user can be delegated a separate user account 
with password protection.

Follow these steps to create a new user account with administrative privileges.

1. On the virtual image desktop, click Start and choose Control Panel.

The Control Panel appears.

2. Click User Accounts.

3. Click Add or remove user accounts.
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The Manage Accounts window appears. 

4. Click Create a new account (circled in the previous figure).

The Create New Account dialog box appears.

5. Type your new user account name in the field circled in the previous figure 
and make sure Administrator is selected.

6. Click Create Account.
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The New Manage Accounts window appears.

The current Administrator account (default) is shown with a blue 
background. After you create a password for the new user account, it 
appears as the default.

7. Click the newly created New_User_Account.

The Change an Account window appears.

8. Click Create a password (circled in the previous figure).

Current Administrator 
Account Default

New user account that is 
being configured.
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The Create Password dialog box appears.

9. Complete the password configuration.

10. Click Create password.

11. Close the window.

12. Click Start and log off the virtual machine.

Topic Description

Password Type a password, then retype the password to 
confirm the entry. 
See page 40 for password requirements.

Passphrase Type a password that contains a string of words and 
characters. Passphrases are generally longer, thus 
more secure, than passwords.

IMPORTANT Remember this password because you need it when you configure your 
FactoryTalk Directory.
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You will see a screen that says ‘Press CTRL + ALT + DELETE to log on’

13. Press CTRL+ALT+INSERT.

IMPORTANT First, click inside the console to activate the controls for your virtual 
machine.

IMPORTANT Even though ‘Press CTRL + ALT + DELETE …’ is displayed on the screen, you 
must press CTRL + ALT + INSERT to access the virtual machine.
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14. Click the newly created New_User_Account.

The New User Account window appears.

15. Type your password and press Return.

The Windows virtual image desktop appears with your personal
account privileges.
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Rename the Computer for Your Location

Follow these steps before using your virtual machine.

1. On the desktop of the virtual machine, right-click the computer icon and 
choose Properties.

2. From the Computer name, domain, and workgroup settings area, click 
Change Settings (on the right side).

3. On the Computer Name tab, click Change.

4. Type a new computer name in the Computer Name box. 

5. Select Domain or Workgroup (default) and click OK.

We recommend that PlantPAx servers and workstations be members of a 
Windows domain for systems with 10 or more computers. The domain 
centralizes administration of the users, groups, and security settings. 

6. Restart the virtual computer to enable the changes to the settings. 

7. Log in by using your domain credentials or local user administration 
account previously created.

IMPORTANT Do not use spaces, hyphens, or any special character symbols.

IMPORTANT To join a domain, the user must have the appropriate domain user 
account with proper credentials to add the computer to the domain.
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Configure Ethernet Network 
Adapter Settings

Use the following procedure to set the speed, duplex, and power management 
settings for the Ethernet adapter.

1. Click Start and choose Control Panel.

2. Click System & Security.

3. Click Network & Internet.

4. Click Network and Sharing Center.

The Network and Sharing Center dialog box appears.

5. Click Change Adapter Settings.

6. Right-click Local Area Connection and choose Properties. 

The Network Properties dialog box appears.

7. Click Configure.

8. Click the Advanced tab.

9. From the Property window, choose Link Speed & Duplex.

10. From the Value menu, choose Auto Negotiation. 

11. Click the Power Management tab.

12. Clear the ‘Allow the computer to turn off this device to save power’ 
checkbox.

13. Click OK.
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Configure the FactoryTalk 
Directory on the PASS

The following procedure assumes that the PASS is going to host the FactoryTalk 
Directory. The directory server manages applications that can exist on multiple 
clients and servers on separate computers on the PlantPAx system.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Tools>FactoryTalk Directory Configuration Wizard.

The FactoryTalk Directory Configuration Wizard appears.

2. Check the following checkboxes:
• Configure the FactoryTalk Network Directory
• Configure the FactoryTalk Local Directory

3. Click Next.

It can take 30 seconds to process the request.

IMPORTANT It is required to have a username and password with Administrator privileges 
to install FactoryTalk software and to specify a FactoryTalk Directory location. 
Use the same username and password for all FactoryTalk installations on the 
PlantPAx system.
You must click inside the console to activate the controls for the
virtual machine.
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4. Type the FactoryTalk Administration Console credentials (see below) for 
the network directory configuration and click Next.

Workgroup: Username: New_user_account
Password: Use the password you created with your 
new_user_account. See page 45.

Domain: Use the username and password of the domain account.

5. Type the credentials for the local directory configuration and click Next.

The password verification occurs twice because you checked both the 
Network and Local Directory checkboxes on the FactoryTalk Directory 
Configuration Wizard.

It can take 30 seconds to process the request.

The network and local directory are now set up and are shown as being 
configured successfully.

6. Click Close.
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Delete the Old Computer Name

The old computer name is embedded in the sample applications. Therefore, if 
you want to use the sample applications, complete the following steps to rehost 
the applications on the new computer name. You delete the old computer name 
from the FactoryTalk Directory by using the Administration Console.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Administration Console.

The FactoryTalk Administrator Console appears.

2. Click Network (default) and click OK.

3. In the Explorer window, browse to Network (THIS COMPUTER) and 
click ‘+’ to expand InstantFizz.

4. Click ‘+’ to expand FTAETag_Area.
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5. Right-click FTAETag_Server and choose Properties.

The FTAETag_Server Properties dialog box appears.

6. From the 'Computer hosting the alarm server' pull-down menu, choose 
your new computer name.

7. Click OK.

8. In the Explorer window, click ‘+’ to expand Samples Water.
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9. Right-click Samples Water AE Alarms and choose Properties.

The Samples Water AE Alarms Properties dialog box appears.

10. Select the new computer name and click OK.

A warning message appears.

11. Click OK.

12. In the Explorer window, choose Network>System>
Computers and Groups>Computers.
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13. Right-click the old computer name that was generated by the operating 
system and choose Delete.

14. Click Yes when a message appears asking you to verify that you want to 
delete the computer name.

15. Exit the FactoryTalk Administrator console.
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Configure the FactoryTalk 
Activation Server

For continuous use of FactoryTalk products and other Rockwell Automation 
software products, computers running the software must have access to activation 
files. FactoryTalk Activation software provides a secure, software-based system 
for activating Rockwell Automation software products and managing software 
activation files. With FactoryTalk Activation software, there is no need for a 
physical master disk or any physical media. Instead, activation files are generated 
and distributed electronically. 

Concurrent activations are locked to a central activation-server computer on the 
network. The activation server manages a pool of activation keys for connected 
clients to share. Floating concurrent activations are assigned automatically to 
clients that need them, and returned automatically to the activation server pool 
when the software stops running on the client, or when the client computer
shuts down.

Client computers must be configured to obtain floating activations from the 
activation server. A continuous network connection is also required for clients to 
use floating activations. After a client obtains a floating activation, if the 
activation server detects that the client has been disconnected, the activation is 
returned to the server pool.

IMPORTANT We recommend that the PASS server be designated as the FactoryTalk 
activation server.

Table 2 - Activation Considerations

Consideration Details

Software that is not activated If the components you have installed cannot be activated, for example, because the activation server is unavailable, 
then the software continues to run for up to seven days. The seven-day grace period provides time to correct the 
problem with acquiring activations, without disrupting critical applications. If activation is restored within seven days, 
normal operations resume. If activation is not restored, the grace period expires. After the grace period expires, if you 
restart the components and activation remains unavailable, the software runs for two hours in Demo mode.

Location of activation server The PASS is the primary choice for activation management and is recommended to be the location of the activation 
server. In the instance that the PASS is not an acceptable location, for example, when you make use of a redundant PASS 
solution, the EWS is the secondary choice. In this instance, the EWS can be a dedicated station with a permanent 
Ethernet connection to the system. The FactoryTalk Activation software can be configured to run as both a server and
client utility.

Options for adding activation files to the PASS To make concurrent floating activations available to activation clients, first you must download the activation files to 
the activation server computer, from the Rockwell Automation Activation window.
If the PASS has internet access, see Open Activation Manager on page 57.
If the PASS does not have internet access, the activations can be downloaded on a different computer with internet 
connectivity and then transferred to the PASS.

Protect activation files Activation files are simple text files that must have a .lic extension. 
As long as the .lic extension is retained, you can copy or rename an activation file without harming it. However, 
tampering with text inside the activation file can disable your Rockwell Software® products. 
If an activation file is damaged or deleted, contact Rockwell Automation Technical Support.
For safekeeping, keep an original set of your activation files on back-up media. Use descriptive names for the files, so 
that you can identify them later, and copy them back to the appropriate computers.
Activation files are locked to the Host IDs of the computers (or dongles) that need them. Activation fails for Rockwell 
Software products on a computer where the specified Host ID is not recognized by the activation file.
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Open Activation Manager

On the Activation Manager computer, start the activation process by opening the 
Activation Manager.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Activation>FactoryTalk Activation Manager.

The FactoryTalk Activation Manager window appears.

2. For instructions on installing FactoryTalk activations, click Help (circled 
in the previous figure).

3. Use the Help instructions to complete the activations.

After completing the activation process, your PASS is ready to use.

Microsoft SQL Server 2008 
Express Account Information

During installation, the following account information was used for Microsoft 
SQL Server 2008 Express: 

User Name Password

SA Rockwell1!
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Notes:
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Chapter 3

Configure the EWS and OWS System Elements

This chapter describes how to configure workstations for your virtual 
environment. The configuration procedures for the EWS and OWS are similar 
even though these PlantPAx system elements operating differently. These 
procedures include:

• Setting up Windows 7 Professional for the new instance
• Setting up the Network Adapter
• Setting up FactoryTalk Directory
• Setting up activation files

The engineering workstation (EWS) supports system configuration, application 
development, and maintenance functions. This is the central location for 
monitoring and maintaining the system’s operation.

The operator workstation (OWS) is not meant to support development or 
maintenance activities. The purpose of this workstation is to support operator 
interaction with a graphical view and interface into the process.

The required Rockwell Automation software for the EWS and OWS 
workstations virtual template is included and pre-installed in the virtual image 
templates, but not activated. To activate each EWS or OWS virtual template, 
you can purchase a single activation license for each virtual template instance.

See page 9 for product catalog numbers.

The table shows the topics in this section.  

IMPORTANT If you already own individual product activations, these activations also can be 
used to activate the virtual image templates.

Topic Page

Before You Begin 60

Configure Microsoft Windows 7 Professional 60

Configure Ethernet Network Adapter Settings 65

Define the FactoryTalk Directory Location 66

Configure the FactoryTalk Activation Server 67

Microsoft SQL Server 2008 Express Account Information 69
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Before You Begin You must deploy your template from the USB drive or from a cloned template to 
perform the following procedures in this chapter. If you need to deploy the 
template, see Chapter 1 on page 13 for details.

Configure Microsoft Windows 
7 Professional

Complete these steps to configure Microsoft Windows 7 Professional settings for 
the EWS and OWS workstations on your virtual machine.

1. If the vSphere Client is not already open, on a computer with VMware 
vSphere Client software installed, click Start and choose All 
Programs>VMware>VMware vSphere Client.

2. In the organizer tree, click the name of the virtual machine you want to 
configure.

3. Click the Console tab.

4. In the Organizer tree, right-click the virtual machine and choose 
Power>Power On. 

IMPORTANT During the configuration of EWS and OWS, you can encounter a User Account 
Control window that asks if you want to allow a program to make changes to 
the computer. Click Yes and continue on.
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The Microsoft Windows Set Up Windows dialog box appears. 

5. Choose the appropriate option from the following pull-down menus.

6. Click Next.

IMPORTANT This screen can remain black for several minutes.

Menu Description

Country or region Choose your country or region, for example,
United States.

Time and currency Choose your time and currency, for example, English 
(United States).

Keyboard layout Choose your keyboard layout, for example, US.
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The Set Up Window dialog box shows the user name and computer name.

7. Type information in the Set Up Windows dialog box.

8. Click Next.

Topic Description

Type a user name Type a user name for the virtual machine.

Type a computer name Type a computer name.

IMPORTANT You need the user name again when you configure your
FactoryTalk Directory.
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The Set Up Window dialog box shows the account password.

9. Type information in the Set Up Windows dialog box.

10. Click Next.

The License Agreement appears.

11. Read the license agreement, and then click ‘I accept the license terms’.

12. Click Next.

Topic Description

Type a password Type a password.

Retype your password Retype the password.

Type a password hint Type a hint that reminds you of the password.

IMPORTANT You need the password again when you configure your
FactoryTalk Directory.
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The Windows Update window appears.

13. Click Ask me later. 

14. From the Time Zone pull-down menu, choose your time zone.

15. If you need to, click ‘Automatically adjust clock for Daylight Savings Time’.

16. Click Next.

The Set Up Window shows the current location options.

17. Click Work Network.

A message appears indicating that ‘Windows is finalizing your settings’.

The desktop of the virtual machine then opens.

Rename the Computer for Your Location

You have an option of giving the computer a different name than the one assigned 
during configuration of the Windows settings or add the workstation to a 
domain by following these steps:

1. On the desktop of the virtual machine, right-click the computer icon and 
choose Properties.

2. From the Computer name, domain, and workgroup settings area, click 
Change Settings (on the right side).

3. On the Computer Name tab, click Change.

4. In the Computer Name box, type a computer name.

IMPORTANT Do not use spaces, hyphens, or any special character symbols.
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5. Select Domain or Workgroup (default) and click OK. 

We recommend that PlantPAx servers and workstations be members of a 
Windows domain for systems with 10 or more computers. The domain 
centralizes administration of the users, groups, and security settings.

6. When prompted, restart the virtual computer to enable the changes to the 
settings. 

7. Log in by using your domain credentials or local user administration 
account previously created.

Configure Ethernet Network 
Adapter Settings

Use the following procedure to set the speed, duplex, and power management 
settings for the Ethernet adapter.

1. Click Start and choose Control Panel.

2. Click System & Security.

3. Click Network & Internet.

4. Click Network and Sharing Center.

The Network and Sharing Center dialog box appears.

5. Click Change Adapter Settings.

6. Right-click Local Area Connection and choose Properties. 

The Network Properties dialog box appears.

7. Click Configure.

8. Click the Advanced tab.

9. From the Property window, choose Link Speed & Duplex.

10. From the Value menu, choose Auto Negotiation. 

11. Click the Power Management tab.

12. Clear the ‘Allow the computer to turn off this device to save power’ 
checkbox.

13. Click OK.

IMPORTANT To join a domain, the user must have the appropriate domain user 
account with proper credentials to add the computer to the domain.
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Define the FactoryTalk 
Directory Location

Complete the following steps to specify the Network FactoryTalk Directory 
location for the EWS and OWS workstations. Complete these steps for each 
workstation.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Tools>Specify FactoryTalk Directory Location.

The FactoryTalk Directory Server Location Utility appears.

2. Click Browse (ellipsis '…' in box).

3. Type your FactoryTalk Directory Administration Console credentials into 
the login screen and click OK.

4. Click Remote computer. 

Click Browse (ellipsis '…' in box) to navigate the network to find the 
computer name of the PASS server that is hosting the FactoryTalk
Directory services.

If Browse is inactive, type the FactoryTalk host computer name.

5. Choose the appropriate PASS server name and click OK.

The Network FactoryTalk Directory location has now been specified.

6. When prompted, enter your credentials and click OK.

7. Restart the server or workstation after making a change.

IMPORTANT Browse may be inactive if Network Discovery & File Share is not turned on.

IMPORTANT Repeat all steps for each workstation.
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Configure the FactoryTalk 
Activation Server

For continuous use of FactoryTalk products and other Rockwell Automation 
software products, computers running the software must have access to activation 
files. FactoryTalk Activation software provides a secure, software-based system 
for activating Rockwell Automation software products and managing software 
activation files. With FactoryTalk Activation software, there is no need for a 
physical master disk or any physical media. Instead, activation files are generated 
and distributed electronically.

Concurrent activations are locked to a central activation-server computer on the 
network. The activation server manages a pool of activation keys for connected 
clients to share. Floating concurrent activations are assigned automatically to 
clients that need them, and returned automatically to the activation server pool 
when the software stops running on the client, or when the client computer
shuts down.

Client computers must be configured to obtain floating activations from the 
activation server. A continuous network connection is also required for clients to 
use floating activations. After a client obtains a floating activation, if the 
activation server detects that the client has been disconnected, the activation is 
returned to the server pool.

Table 3 - Activation Considerations

Consideration Details

Software that is not activated If the components you have installed cannot be activated, for example, because the activation server is unavailable, 
then the software continues to run for up to seven days. The seven-day grace period provides time to correct the 
problem with acquiring activations, without disrupting critical applications. If activation is restored within seven days, 
normal operations resume. If activation is not restored, the grace period expires. After the grace period expires, if you 
restart the components and activation remains unavailable, the software runs for two hours in Demo mode.

Location of activation server The PASS is the primary choice for activation management and is recommended to be the location of the activation 
server. In the instance that the PASS is not an acceptable location, for example, when you make use of a redundant PASS 
solution, the EWS is the secondary choice. In this instance, the EWS can be a dedicated station with a permanent 
Ethernet connection to the system. The FactoryTalk Activation software can be configured to run as both a server and
client utility.

Options for adding activation files to the PASS To make concurrent floating activations available to activation clients, first you must download the activation files to 
the activation server computer, from the Rockwell Automation Activation window.
If the PASS has internet access, see Open Activation Manager on page 68.
If the PASS does not have internet access, the activations can be downloaded on a different computer with internet 
connectivity and then transferred to the PASS.

Protect activation files Activation files are simple text files that must have a .lic extension. 
As long as the .lic extension is retained, you can copy or rename an activation file without harming it. However, 
tampering with text inside the activation file can disable your Rockwell Software products. 
If an activation file is damaged or deleted, contact Rockwell Automation Technical Support.
For safekeeping, keep an original set of your activation files on back-up media. Use descriptive names for the files, so 
that you can identify them later, and copy them back to the appropriate computers.
Activation files are locked to the Host IDs of the computers (or dongles) that need them. Activation fails for Rockwell 
Software products on a computer where the specified Host ID is not recognized by the activation file.
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Open Activation Manager

On the Activation Manager computer, start the activation process by opening the 
Activation Manager.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Activation>FactoryTalk Activation Manager.

The FactoryTalk Activation Manager window appears.

2. For instructions on installing FactoryTalk activations, click Help (circled 
in the previous figure).

3. Use the Help instructions to complete the activations.

After completing the activation process, your workstation or workstations 
are ready to use.

Update Activation Search Path

After the license files are on the PASS, you must update the Activation Search 
Path on the workstations.

1. If the Activation Manager is not already open, on the OWS or EWS 
computer, click Start and choose All Programs>
Rockwell Software>FactoryTalk Activation>
FactoryTalk Activation Manager.

2. Click Find Available Activations.

The Manage Activations section appears on the FactoryTalk Activation 
Manager window.
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3. Click Update Activation Search Path.

The Update Activation Search Path window appears.

4. Click Add Server.

5. Click Browse (ellipsis ‘…’ in box).

The Browse for Server message window appears.

6. Select the PASS in the network and click OK.

The name of the PASS computer appears in the table under Path to 
Activations.

7. Check the box next to the name of the PASS computer.

8. Click ‘Up’ so that the PASS computer moves to the top of the list.

9. Click Save.

10. Click Refresh Activations.

Available activations appear in the table.

11. Complete steps 1…10 for all OWS and EWS workstations.

Microsoft SQL Server 2008 
Express Account Information

During installation, the following account information was used for Microsoft 
SQL Server 2008 Express: 

User Name Password

SA Rockwell1!
Rockwell Automation Publication 9528-UM001D-EN-P - March 2015 69



Chapter 3 Configure the EWS and OWS System Elements
Notes:
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Chapter 4

Configure Application Server OWS 
(Microsoft Remote Desktop Services)

The Application Server OWS (AppServ-OWS) provides PlantPAx users with an 
alternative to the standard OWS client machine (physical or virtual). AppServ-
OWS uses Microsoft Remote Desktop Services (RDS) technology to serve 
multiple instances of the OWS from a single server virtual template. This 
architecture is ideal for PlantPAx users wishing to use Thin Clients as Operator 
Work Stations.

This chapter provides you with the procedures necessary to deploy the 
Application Server OWS (AppServ-OWS) virtual template:

• Setting up Windows Server 2008 for the new instance
• Setting up the Network Adapter
• Setting up FactoryTalk Directory
• Setting up activation files
• Configure Remote Desktop Services

For more information regarding recommended architecture and the actual 
configuration of the Application Server, see the PlantPAx Process Automation 
System Reference Manual, publication PROCES-RM001, and the specific 
product documentation.

The required Rockwell Automation software for the AppServ-OWS virtual 
template is included and pre-installed in the virtual image templates, but not 
activated. You need an activation license for each client connection.

See page 9 for product catalog numbers.

IMPORTANT If you already own individual product activations, these activations also can be 
used to activate the virtual image templates.
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The table shows the topics in this section.  

Before You Begin You must deploy your template from the USB drive or from a cloned template to 
perform the following procedures in this chapter. If you need to deploy the 
template, see Chapter 1 on page 13 for details.

Configure Microsoft Windows 
Server 2008

Complete these steps on a virtual machine to initiate the Microsoft Windows 
Server 2008 operating system setup for the Application Server OWS. You set 
your own administration account password, computer name, and file location 
preference in this procedure.

1. If the vSphere Client is not already open, on a computer with VMware 
vSphere Client software installed, click Start and choose All 
Programs>VMware>VMware vSphere Client.

2. In the organizer tree, click the name of the virtual machine.

3. Click the Console tab.

Topic Page

Before You Begin 72

Configure Microsoft Windows Server 2008 72

Configure the Ethernet Network Adapter Settings 84

Define the FactoryTalk Directory Location 85

Configure the FactoryTalk Activation Server 86

Configure Remote Desktop Services 89

Microsoft Remote Desktop Services Licensing 92

Install Additional Software 92

Add Remote Desktop Services Users 92

IMPORTANT During the configuration of Application Server OWS, you can encounter a User 
Account Control dialog box that asks if you want to allow a program to make 
changes to the computer. Click Yes and continue on.
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4. In the Organizer tree, right-click the virtual machine and choose 
Power>Power On.  

You see this window during initial setup.

IMPORTANT The screen can remain black for several minutes.
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The Microsoft Windows Set Up Windows dialog box appears.  

5. Choose the appropriate option from the following pull-down menus.

6. Click Next.

The License Agreement appears. This agreement includes
Microsoft Windows, Rockwell Automation Software, and Adobe Reader.

7. Read the license agreement, and then click ‘I accept the license terms’.

8. Click Start.

You will see a screen that says ‘Press CTRL + ALT + DELETE to log on’.

IMPORTANT First, click inside the console to activate the controls for your virtual 
machine.

Menu Description

Country or region Choose your country or region, for example,
United States.

Time and currency Choose your time and currency, for example, English 
(United States).

Keyboard layout Choose your keyboard layout, for example, US.
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9. Press CTRL+ALT+INSERT’

The icon for the Administrator account is displayed. 

10. Click the Administrator icon.

IMPORTANT Even though ‘Press CTRL + ALT + DELETE …’ is displayed on the screen, you 
must press CTRL + ALT + INSERT to access the virtual machine.
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You will see a message stating 'The user’s password must be changed before 
logging in the first time.' 

11. Click OK.

The Administrator account dialog box appears so you can change
a password.  
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12. Type a password, then verify the entry by typing the same password in the 
second entry field.

13. Click the arrow.

14. Click OK to acknowledge your password has been changed.

The virtual image desktop appears.

IMPORTANT Passwords must meet the following minimum requirements:
• Cannot contain the user's account name or parts of the user's full 

name that exceed two consecutive characters
• Must be at least six characters in length
• Must contain characters from three of the following four 

categories:
– English uppercase characters (A…Z)
– English lowercase characters (a…z)
– Base 10 digits (0…9).
– Non-alphabetic characters (for example, !, $, #, %).

IMPORTANT The default time zone for Windows Server 2008 is Pacific Time. If you are not in 
the Pacific Time zone, you need to change time zone and update the time.
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Create an Administrator User Account

We suggest that you create an Administrator user account for each user that 
requires administrative privileges. This best practice safeguards server corruption 
by restricting access to the default administrative account, and creates a backup of 
critical system information. Each user can be delegated a separate user account 
with password protection.

Follow these steps to create a new user account with administrative privileges.

1. On the virtual image desktop, click Start and choose Control Panel.

The Control Panel appears.

2. Click User Accounts.

3. Click Add or remove user accounts (circled in the previous figure).
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The Manage Accounts window appears. 

4. Click Create a new account (circled in the previous figure).

The Create New Account dialog box appears.

5. Type your new user account name (circled in the previous figure) and 
make sure Administrator is selected.

6. Click Create Account.
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The New Manage Accounts window appears.

The current Administrator account (default) is shown with a blue 
background. After you create a password for the new user account, it 
appears as the default.

7. Click the newly created New_User_Account.

The Change an Account window appears.

8. Click Create a password (circled in the previous figure).

Current Administrator 
Account Default

New user account that is 
being configured.
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The Create Password dialog box appears.

9. Complete the password configuration.

10. Click Create password.

11. Close the window.

12. Click Start and log off the virtual machine.

Topic Description

Password Type a password, then retype the password to 
confirm the entry. 
See page 77 for password requirements.

Passphrase Type a password that contains a string of words and 
characters. Passphrases are generally longer, thus 
more secure, than passwords.

IMPORTANT Remember this password because you need it when you configure your 
FactoryTalk Directory.
Rockwell Automation Publication 9528-UM001D-EN-P - March 2015 81



Chapter 4 Configure Application Server OWS (Microsoft Remote Desktop Services)
You will see a screen that says ‘Press CTRL + ALT + DELETE to log on’

13. Press CTRL+ALT+INSERT.

IMPORTANT First, click inside the console to activate the controls for your virtual 
machine.

IMPORTANT Even though ‘Press CTRL + ALT + DELETE …’ is displayed on the screen, you 
must press CTRL + ALT + INSERT to access the virtual machine.
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14. Click the newly created New_User_Account.

The New User Account window appears.

15. Type your password and press Return.

The Windows virtual image desktop appears with your personal
account privileges.

Rename the Computer for Your Location

Follow these steps before using your virtual machine.

1. On the desktop of the virtual machine, right-click the computer icon and 
choose Properties.

2. From the Computer name, domain, and workgroup settings area, click 
Change Settings (on the right side).

3. On the Computer Name tab, click Change.

4. Type a new computer name in the Computer Name box. 

IMPORTANT Do not use spaces, hyphens, or any special character symbols.
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5. Select Domain or Workgroup (default) and click OK.

We recommend that PlantPAx servers and workstations be members of a 
Windows domain for systems with 10 or more computers. The domain 
centralizes administration of the users, groups, and security settings. 

6. Restart the virtual computer to enable the changes to the settings. 

7. Log in by using your domain credentials or local user administration 
account previously created.

Configure the Ethernet 
Network Adapter Settings

Use the following procedure to set the speed, duplex, and power management 
settings for the Ethernet adapter.

1. Click Start and choose Control Panel.

2. Click System & Security.

3. Click Network & Internet.

4. Click Network and Sharing Center.

The Network and Sharing Center dialog box appears.

5. Click Change Adapter Settings.

6. Right-click Local Area Connection and choose Properties. 

The Network Properties dialog box appears.

7. Click Configure.

8. Click the Advanced tab.

9. From the Property window, choose Link Speed & Duplex.

10. From the Value menu, choose Auto Negotiation. 

11. Click the Power Management tab.

12. Clear the ‘Allow the computer to turn off this device to save power’ 
checkbox.

13. Click OK.

IMPORTANT To join a domain, the user must have the appropriate domain user 
account with proper credentials to add the computer to the domain.
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Define the FactoryTalk 
Directory Location

Complete the following steps to specify the Network FactoryTalk Directory 
location for AppServ-OWS.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Tools>Specify FactoryTalk Directory Location.

The FactoryTalk Directory Server Location Utility appears.

2. Click Browse (ellipsis '…' in box).

3. Type your FactoryTalk Directory Administration Console credentials into 
the login screen and click OK.

4. Click Remote computer.

Click Browse (ellipsis '…' in box) to navigate the network to find the 
computer name of the PASS server that is hosting the FactoryTalk
Directory services.

5. Choose the appropriate PASS server name and click OK.

The Network FactoryTalk Directory location has now been specified.

6. When prompted, enter your credentials and click OK.

7. Restart the server after making this change.
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Configure the FactoryTalk 
Activation Server

For continuous use of FactoryTalk products and other Rockwell Automation 
software products, computers running the software must have access to activation 
files. FactoryTalk Activation software provides a secure, software-based system 
for activating Rockwell Automation software products and managing software 
activation files. With FactoryTalk Activation software, there is no need for a 
physical master disk or any physical media. Instead, activation files are generated 
and distributed electronically.

Concurrent activations are locked to a central activation-server computer on the 
network. The activation server manages a pool of activation keys for connected 
clients to share. Floating concurrent activations are assigned automatically to 
clients that need them. These activations are returned automatically to the 
activation server pool when the software stops running on the client, or when the 
client computer shuts down.

Client computers must be configured to obtain floating activations from the 
activation server. A continuous network connection is also required for clients to 
use floating activations. After a client obtains a floating activation, if the 
activation server detects that the client has been disconnected, the activation is 
returned to the server pool.

Table 4 - Activation Considerations

Consideration Details

Software that is not activated If the components you have installed cannot be activated, for example, because the activation server is unavailable, 
then the software continues to run for up to seven days. The seven-day grace period provides time to correct the 
problem with acquiring activations, without disrupting critical applications. If activation is restored within seven days, 
normal operations resume. If activation is not restored, the grace period expires. After the grace period expires, if you 
restart the components and activation remains unavailable, the software runs for two hours in Demo mode.

Location of activation server The PASS is the primary choice for activation management and is recommended to be the location of the activation 
server. In the instance that the PASS is not an acceptable location, for example, when you make use of a redundant PASS 
solution, the EWS is the secondary choice. In this instance, the EWS can be a dedicated station with a permanent 
Ethernet connection to the system. The FactoryTalk Activation software can be configured to run as both a server and
client utility.

Options for adding activation files to the PASS To make concurrent floating activations available to activation clients, first you must download the activation files to 
the activation server computer, from the Rockwell Automation Activation window.
If the PASS has internet access, see Open Activation Manager on page 87.
If the PASS does not have internet access, the activations can be downloaded on a different computer with internet 
connectivity and then transferred to the PASS.

Protect activation files Activation files are simple text files that must have a .lic extension. 
As long as the .lic extension is retained, you can copy or rename an activation file without harming it. However, 
tampering with text inside the activation file can disable your Rockwell Software products. 
If an activation file is damaged or deleted, contact Rockwell Automation Technical Support.
For safekeeping, keep an original set of your activation files on back-up media. Use descriptive names for the files, so 
that you can identify them later, and copy them back to the appropriate computers.
Activation files are locked to the Host IDs of the computers (or dongles) that need them. Activation fails for Rockwell 
Software products on a computer where the specified Host ID is not recognized by the activation file.
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Open Activation Manager

On the Activation Manager computer, start the activation process by opening the 
Activation Manager.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Activation>FactoryTalk Activation Manager.

The FactoryTalk Activation Manager window appears.

2. For instructions on installing FactoryTalk activations, click Help.

3. Use the Help instructions to complete the activations.

After completing the activation process, your AppServ-OWS is 
ready to use.

Update Activation Search Path

After the license files are on the PASS, you must update the Activation Search 
Path on AppServ-OWS.

1. If the Activation Manager is not already open, click Start and choose 
All Programs>Rockwell Software>FactoryTalk Activation>
FactoryTalk Activation Manager.

2. Click Find Available Activations.

The Manage Activations section appears on the FactoryTalk Activation 
Manager window.

3. Click Update Activation Search Path.
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The Update Activation Search Path window appears.

4. Click Add Server.

5. Click Browse (ellipsis ‘…’ in box).

The Browse for Server message window appears.

6. Select the PASS in the network and click OK.

The name of the PASS computer appears in the table under Path to 
Activations.

7. Check the box next to the name of the PASS computer.

8. Click ‘Up’ so that the PASS computer moves to the top of the list.

9. Click Save.

10. Click Refresh Activations.

Available activations appear in the table.
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Configure Remote Desktop 
Services

The Application Server OWS provides PlantPAx users with an alternative to the 
standard OWS client machine (physical or virtual). The AppServ-OWS uses 
Microsoft Remote Desktop Services (RDS) technology to serve multiple 
instances of the OWS from a single server Virtual Template. This architecture is 
ideal for PlantPAx users wishing to use Thin Clients as Operator Work Stations.  

Microsoft RDS (formerly known as Terminal Services) is a standard Role 
built into the Windows Server family of operating systems that allows remote 
access to applications and data on a remote computer over a network. 

RDS can be used as an administrative tool to connect to a remote machine and 
perform maintenance tasks. RDS can also be used as a thin client solution to let 
remote clients to execute applications or even access the entire desktop of the host 
server. 

The thin client solution is a transparent system that runs applications and 
performs data processing and storage functions on a remote computer. This 
solution minimizes the amount of information traveling across your network. 
While multiple sessions can run on a single server, each user can see only their 
individual session. Only the user interface is shown on client, user input from 
client is redirected over the network to the remote desktop session. User's 
desktops are transmitted to clients for display by using terminal emulation 
software. Similarly, the software sends command functions such as keyboard 
inputs and mouse clicks across the network between the client and the server. 

The PlantPax AppServ-OWS has been pre-configured with the Microsoft 
Remote Desktop server role and the FTView SE Client 7.0 application. This 
configuration provides a thin client solution for FactoryTalk View SE Clients. 

IMPORTANT A valid FactoryTalk activation is still required for each instance of the OWS that 
is in use.
Rockwell Automation Publication 9528-UM001D-EN-P - March 2015 89



Chapter 4 Configure Application Server OWS (Microsoft Remote Desktop Services)
Users, with the proper credentials, can log in into the AppServ-OWS and run the 
FactoryTalk View SE Client application. 

One FactoryTalk View SE client activation key is required for each Remote 
Desktop Session in which FactoryTalk View SE client is run. The first instance of 
FactoryTalk View SE client loaded within a Remote Desktop Session acquires an 
activation key. Any additional FactoryTalk View SE clients that are started within 
a session do not require additional keys. 

Remote Desktop Services with FactoryTalk View SE

The benefits of using Remote Desktop Services with FactoryTalk View SE 
include the following:

• Increased network flexibility: RDS lets you deploy thin and ultrathin 
clients on the plant floor or out in the field. The minimal requirements of 
RDS Clients allow for various thin products that are designed to handle 
most environmental conditions. These conditions include radical 
temperatures, extreme vibrations, or areas where mobility is key. Users can 
gain access to an RDS over any Transmission Control Protocol/Internet 
Protocol (TCP/IP) connection including Remote Access, Ethernet, the 
Internet, wireless, wide area network (WAN), or virtual private network 
(VPN). 

• Lower cost of ownership: A thin client typically consists only of the 
Operating System and the Remote Desktop Connection software. RDS 
delivers a virtual Windows Server 2008 R2 experience from server to 
clients, regardless of what Operating System the client uses. 

• Minimize downtime: Upgrade your entire FactoryTalk View SE 
installation with a single operation. Because FactoryTalk View SE products 
install only on the server side, any future software upgrades are limited to 
the server, making software upgrades on clients a thing of the past. 

• Improve data security: A FactoryTalk View SE architecture that uses 
RDS is less vulnerable to security threats. RDS lets you focus your security 
measures on the server because all data is processed on the server, which 
you can manage in a secure location. 

The known limitations when using Remote Desktop Services with FactoryTalk 
View SE include the following:

TIP For more information, see Knowledgebase Answer ID 567658 - Using 
FactoryTalk View SE with Windows 2008 R2 Remote Desktop Services - Getting 
Started Whitepaper at 
https://rockwellautomation.custhelp.com/app/answers/detail/a_id/567658
You must have a TechConnect license to download the library.
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• The Microsoft RDS protocol does not transfer the physical display aspect 
ratio (height/width proportion) from the server to its clients. Clients need 
to specify the display properties (resolution, aspect ratio, color depth, and 
so on) for each session they create. Verify the appearance of the application 
visually on the Remote Desktop Clients before placing the system in a 
production environment, modifying graphics as necessary. 

• When the FactoryTalk View SE Server is also the Remote Desktop Session 
Host, it is possible that thin clients cannot add/change pens in a trend. 

• If your FactoryTalk View SE client configuration (.cli) enables 'Show 
Diagnostics List', the list shows all activity from all clients running on the 
same Remote Desktop Session Host. This activity is due to the fact that 
although each instance of the FactoryTalk View SE client runs in a separate 
session, they are all hosted on the same computer and share common log 
resources. This amount of activity can be confusing for HMI operators 
because they see diagnostic activity on their client that they did not 
initiate. 

• Using the Tag Import and Export Wizard does not work correctly when 
used in a Remote Desktop Client session. Run this wizard only from a 
FactoryTalk View Studio instance on the HMI Server console. Using a 
Remote Desktop Client to connect to the console session can avoid this 
issue, but is not recommended. 

PlantPAx AppServ-OWS Base Configuration 

TIP For more information, see Knowledgebase Answer ID 32715 - Cannot 
add/change pens in trend from SE client on Terminal Server at 
https://rockwellautomation.custhelp.com/app/answers/detail/a_id/
32715.

IMPORTANT You can add additional role services to your server depending on your specific 
deployment of Remote Desktop Services and connectivity needs. These added 
services can add additional configuration beyond which this base Remote 
Desktop Server has been configured for.
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Microsoft Remote Desktop 
Services Licensing

RDS has its own method for licensing clients that log in to RDS servers, separate 
from the licensing for the Windows Server 2008 R2 family of operating systems. 
Remote Desktop Connections must receive a valid license issued by a Remote 
Desktop Licensing Server before they can log in to a Remote Desktop Session 
Host or Connection Broker.

One Remote Desktop Licensing Server can serve multiple RDS servers 
concurrently; therefore, you can either leverage an existing Remote Desktop 
Licensing Server or create your own.

Install Additional Software Before you install any application, place the Remote Desktop Session Host server 
into a special installation mode. Placing the server into this special installation 
mode will ensure that patches and additional software are installed correctly to 
work in a multiuser environment. Failure to use the special installation mode can 
prevent an application from functioning properly.

Install Special Mode

Put the Remote Desktop Session Host into the special installation mode by 
Clicking Start and choosing Control Panel>Programs>Install Application on 
Remote Desktop.

After the application is installed, you must put the RD Session Host server back 
into execution mode before remote users begin using the application. The Install 
Application on Remote Desktop Session Host tool automatically puts the RD 
Session Host server into execution mode when it is finished running, but always 
verify before continuing.

It is important to put the Remote Desktop Session Host server back into 
execution mode before running any of the installed applications. Some 
applications cannot execute properly or can have loss of functionality if the server 
is not put back into execution mode.

Add Remote Desktop 
Services Users

Each user who logs in to an RDS server must have a user account either on the 
server or in a domain on the network that the server is on. The user account 
contains additional information that determines when user can log in, under 
what conditions, and how specific desktop settings are stored. Windows Server 
2008 R2 family operating systems contain a built-in User group called Remote 
Desktop Users, which is used to manage RDS users.

On the Select User Groups Allowed Access to This RD Session Host Server page, 
select the users and/or groups that can connect to the Remote Desktop Session 
Host Server and click Next.

Alternatively, you can add additional users later via the Local Users and Groups 
option in Computer Management.
92 Rockwell Automation Publication 9528-UM001D-EN-P - March 2015



Chapter 5

Configure Application Server Historian

This chapter provides you with the details necessary to deploy the Application 
Server Historian (AppServ-Hist) virtual template. AppServ-Hist (based on 
FactoryTalk Historian) satisfies the Data Collection role of the PlantPAx system 
architecture.

This chapter provides you with the procedures necessary to deploy the 
Application Server Historian (AppServ-Hist) virtual template:

• Setting up Windows Server 2008 for the new instance
• Setting up the Network Adapter
• Setting up FactoryTalk Directory
• Setting up activation files
• Rename SQL Server
• Install and configure Historian Asset Framework

For more information regarding recommended architecture and the actual 
configuration of the Application Server, see the PlantPAx Process Automation 
System Reference Manual, publication PROCES-RM001, and the specific 
product documentation.

The required Rockwell Automation software for the AppServ-Hist virtual 
template is included and pre-installed in the virtual image templates, but not 
activated. Use an individual FactoryTalk Historian SE activation license to 
activate each AppServ-Hist virtual template.

See page 9 for product catalog numbers.

The table shows the topics in this section.  

Topic Page

Before You Begin 94

Configure Microsoft Windows Server 2008 94

Configure the Ethernet Network Adapter Settings 105

Define the FactoryTalk Directory Location 106

Configure the FactoryTalk Activation Server 107

Rename SQL Server 109

Install Historian Asset Framework (AF) 111
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Chapter 5 Configure Application Server Historian
This template represents a base installation of a FactoryTalk Historian Server and 
does not include optional features such as Advanced Server or DataLink. 

Before You Begin You must deploy your template from the USB drive to perform the following 
procedures in this chapter. If you need to deploy the template, 
see Chapter 1 on page 13 for details.

Configure Microsoft Windows 
Server 2008

Complete these steps on a virtual machine to initiate the Microsoft Windows 
Server 2008 operating system setup for the Application Server Historian. You set 
your own administration account password, computer name, and file location 
preference in this procedure.

1. If the vSphere Client is not already open, on a computer with VMware 
vSphere Client software installed, click Start and choose All 
Programs>VMware>VMware vSphere Client.

2. Click the Console tab.

3. In the Organizer tree, right-click the virtual machine and choose 
Power>Power On. 

Delete Old Computer Name 118

Synchronize AF Database 120

Complete Historian Configuration 122

IMPORTANT During the configuration of Application Server Historian, you can encounter a 
User Account Control window that asks if you want to allow a program to make 
changes to the computer. Click Yes and continue on.

TIP To use DataLink, you must install Microsoft Excel yourself by using a valid 
Microsoft Excel license.

Topic Page
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You see this window after initial setup is complete. This stage can take a 
few minutes.

The Microsoft Windows Set Up Windows dialog box appears. 

IMPORTANT First, click inside the console to activate the controls for your virtual 
machine.
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4. Choose the appropriate option from the following pull-down menus.

5. Click Next.

The License Agreement appears. This agreement includes
Microsoft Windows, Rockwell Automation Software, and Adobe Reader.

6. Read the license agreement, and then click ‘I accept the license terms’.

7. Click Start.

8. If you get a message stating 'The User’s password must be changed before 
logging in the first time', click OK.

Menu Description

Country or region Choose your country or region, for example,
United States.

Time and currency Choose your time and currency, for example, English 
(United States).

Keyboard layout Choose your keyboard layout, for example, US.
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The Administrator account dialog box appears so you can change
a password.  

9. Type a password, then verify the entry by typing the same password in the 
second entry field.

10. Click the arrow.

11. Click OK to acknowledge your password has been changed.

IMPORTANT Passwords must meet the following minimum requirements:
• Cannot contain the user's account name or parts of the user's full 

name that exceed two consecutive characters
• Must be at least six characters in length
• Must contain characters from three of the following four 

categories:
– English uppercase characters (A…Z)
– English lowercase characters (a…z)
– Base 10 digits (0…9).
– Non-alphabetic characters (for example, !, $, #, %).
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The virtual image desktop appears.

IMPORTANT The default time zone for Windows Server 2008 is Pacific Time. If you are not in 
the Pacific Time zone, you need to change time zone and update the time.
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Create an Administrator User Account

We suggest that you create an Administrator user account for each user that 
requires administrative privileges. This best practice safeguards server corruption 
by restricting access to the default administrative account, and creates a backup of 
critical system information. Each user can be delegated a separate user account 
with password protection.

Follow these steps to create a new user account with administrative privileges.

1. On the virtual image desktop, click Start and choose Control Panel.

The Control Panel appears.

2. Click Add or remove user accounts (circled in the previous figure).

The Manage Accounts window appears. 
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3. Click Create a new account (circled in the previous figure).

The Create New Account dialog box appears.

4. Type your new user account name (circled in the previous figure) and 
make sure Administrator is selected.

5. Click Create Account.

The New Manage Accounts window appears.

The current Administrator account (default) is shown with a blue 
background. After you create a password for the new user account, it 
appears as the default.

6. Click the newly created New_User_Account.

Current Administrator 
Account Default

New user account that is 
being configured.
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The Change an Account window appears.

7. Click Create a password (circled in the previous figure).

The Create Password dialog box appears.

8. Complete the password configuration.

9. Click Create password.

10. Close the window.

Topic Description

Password Type a password, then retype the password to 
confirm the entry. 
See page 97 for password requirements.

Passphrase Type a password that contains a string of words and 
characters. Passphrases are generally longer, thus 
more secure than passwords.

IMPORTANT Remember this password because you need it when you configure your 
FactoryTalk Directory.
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11. Click Start and log off the virtual machine. 

12. Press CTRL+ALT+INSERT.

IMPORTANT First, click inside the console to activate the controls for your virtual 
machine.

IMPORTANT Even though ‘Press CTRL + ALT + DELETE …’ is displayed on the screen, you 
must press CTRL + ALT + INSERT to access the virtual machine.
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13. Click the newly created New_User_Account.

The New User Account window appears.

14. Type your password and press Return.

The Windows virtual image desktop appears with your personal
account privileges.
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Rename the Computer for Your Location

Follow these steps before using your virtual machine.

1. On the desktop of the virtual machine, right-click the computer icon and 
choose Properties.

2. From the Computer name, domain, and workgroup settings area, click 
Change Settings (on the right side).

3. On the Computer Name tab, click Change.

4. Type a new computer name in the Computer Name box. 

5. Select Domain or Workgroup (default) and click OK.

We recommend that PlantPAx servers and workstations be members of a 
Windows domain for systems with 10 or more computers. The domain 
centralizes administration of the users, groups, and security settings. 

6. Restart the virtual computer to enable the changes to the settings. 

7. Log in by using your domain credentials or local user administration 
account previously created.

IMPORTANT Do not use spaces, hyphens, or any special character symbols.

IMPORTANT To join a domain, the user must have the appropriate domain user 
account with proper credentials to add the computer to the domain.
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Configure the Ethernet 
Network Adapter Settings

Use the following procedure to set the speed, duplex, and power management 
settings for the Ethernet adapter.

1. Click Start and choose Control Panel.

2. Click System & Security.

3. Click Network & Internet.

4. Click Network and Sharing Center.

The Network and Sharing Center dialog box appears.

5. Click Change Adapter Settings.

6. Right-click Local Area Connection and choose Properties. 

The Network Properties dialog box appears.

7. Click Configure.

8. Click the Advanced tab.

9. From the Property window, choose Link Speed & Duplex.

10. From the Value menu, choose Auto Negotiation. 

11. Click the Power Management tab.

12. Clear the ‘Allow the computer to turn off this device to save power’ 
checkbox.

13. Click OK.
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Define the FactoryTalk 
Directory Location

Complete the following steps to specify the Network FactoryTalk Directory 
location for AppServ-Hist.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Tools>Specify FactoryTalk Directory Location.

The FactoryTalk Directory Server Location Utility appears.

2. Click Browse (ellipsis '…' in box).

3. Type your FactoryTalk Directory Administration Console credentials into 
the login screen and click OK.

4. Click Remote computer.

Click Browse (ellipsis '…' in box) to navigate the network to find the 
computer name of the PASS server that is hosting the FactoryTalk
Directory services.

5. Choose the appropriate PASS server name and click OK.

The Network FactoryTalk Directory location has now been specified.

6. When prompted, enter your credentials and click OK.

7. Restart the server after making a change.
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Configure the FactoryTalk 
Activation Server

For continuous use of FactoryTalk products and other Rockwell Automation 
software products, computers running the software must have access to activation 
files. FactoryTalk Activation software provides a secure, software-based system 
for activating Rockwell Automation software products and managing software 
activation files. With FactoryTalk Activation software, there is no need for a 
physical master disk or any physical media. Instead, activation files are generated 
and distributed electronically.

Concurrent activations are locked to a central activation-server computer on the 
network. The activation server manages a pool of activation keys for connected 
clients to share. Floating concurrent activations are assigned automatically to 
clients that need them. These activations are returned automatically to the 
activation server pool when the software stops running on the client, or when the 
client computer shuts down.

Client computers must be configured to obtain floating activations from the 
activation server. A continuous network connection is also required for clients to 
use floating activations. After a client obtains a floating activation, if the 
activation server detects that the client has been disconnected, the activation is 
returned to the server pool.

Table 5 - Activation Considerations

Consideration Details

Software that is not activated If the components you have installed cannot be activated, for example, because the activation server is unavailable, 
then the software continues to run for up to seven days. The seven-day grace period provides time to correct the 
problem with acquiring activations, without disrupting critical applications. If activation is restored within seven days, 
normal operations resume. If activation is not restored, the grace period expires. After the grace period expires, if you 
restart the components and activation remains unavailable, the software runs for two hours in Demo mode.

Location of activation server The PASS is the primary choice for activation management and is recommended to be the location of the activation 
server. In the instance that the PASS is not an acceptable location, for example, when you make use of a redundant PASS 
solution, the EWS is the secondary choice. In this instance, the EWS can be a dedicated station with a permanent 
Ethernet connection to the system. The FactoryTalk Activation software can be configured to run as both a server and
client utility.

Options for adding activation files to the PASS To make concurrent floating activations available to activation clients, first you must download the activation files to 
the activation server computer, from the Rockwell Automation Activation window.
If the PASS has internet access, see Open Activation Manager on page 108.
If the PASS does not have internet access, the activations can be downloaded on a different computer with internet 
connectivity and then transferred to the PASS.

Protect activation files Activation files are simple text files that must have a .lic extension. 
As long as the .lic extension is retained, you can copy or rename an activation file without harming it. However, 
tampering with text inside the activation file can disable your Rockwell Software products. 
If an activation file is damaged or deleted, contact Rockwell Automation Technical Support.
For safekeeping, keep an original set of your activation files on back-up media. Use descriptive names for the files, so 
that you can identify them later, and copy them back to the appropriate computers.
Activation files are locked to the Host IDs of the computers (or dongles) that need them. Activation fails for Rockwell 
Software products on a computer where the specified Host ID is not recognized by the activation file.
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Open Activation Manager

On the Activation Manager computer, start the activation process by opening the 
Activation Manager.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Activation>FactoryTalk Activation Manager.

The FactoryTalk Activation Manager window appears.

2. For instructions on installing FactoryTalk activations, click Help (circled 
in the previous figure).

3. Use the Help instructions to complete the activations.

After completing the activation process, your AppServ-Hist is ready to use.

Update Activation Search Path

After the license files are on the PASS, you must update the Activation Search 
Path on the AppServ-Hist.

1. If the Activation Manager is not already open, click Start and choose 
All Programs>Rockwell Software>FactoryTalk Activation>
FactoryTalk Activation Manager.

2. Click Find Available Activations.

The Manage Activations section appears on the FactoryTalk Activation 
Manager window.

3. Click Update Activation Search Path.
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The Update Activation Search Path window appears.

4. Click Add Server.

5. Click Browse (ellipsis ‘…’ in box).

The Browse for Server message window appears.

6. Select the PASS in the network and click OK.

The name of the PASS computer appears in the table under Path to 
Activations.

7. Check the box next to the name of the PASS computer.

8. Click ‘Up’ so that the PASS computer moves to the top of the list.

9. Click Save.

10. Click Refresh Activations.

Available activations appear in the table.

Rename SQL Server As a result of the Sysprep process (used to build the template) and subsequent 
renaming of server, it is necessary to use the SQL Server Rename Tool to grant 
SysAdmin rights to the local administrator of the renamed SQL Server Express 
instance on the virtual image.

Perform the following steps.

1. On the desktop, double-click the PlantPAx Utilities icon. 

The PlantPAx Utilities directory opens. 
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2. In the Microsoft Windows Explorer window that appears, double-click 
SQL Server Rename Tool directory (circled in the previous figure). 

3. In the SQL Server Rename Tool directory, double-click the 
'addselftosqlsysadmin.cmd' file name. 

A command window opens with the default name for the SQL instance 
name. 

4. In the window that appears, press Enter to accept SQLEXPRESS as the 
name of the SQL Instance name. 

The name change is processed and can take a few minutes. 

5. Verify that 'Computername\Administrator' was successfully added to the 
'sysadmin' role is displayed on the screen (circled in the previous figure). 

6. Press any key to close this window.
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Install Historian Asset 
Framework (AF)

You must install the Historian Asset Framework (AF) by using the installation 
wizard. Perform the following steps.

1. On the desktop, double-click the AppServ-Hist Software Install Files icon. 
The AppServ-Hist Software Install Files directory opens. 
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2. In the window that appears, double-click the 'DVD' directory (circled in 
the previous figure). 

The 'DVD' directory is opened. 

3. Double-click 'setup.exe' (circled in the previous figure). 
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The FactoryTalk Historian Site Edition main page appears. 

4. Click 'Install FactoryTalk Historian Site Edition' (circled in the previous 
figure). 

The Install FactoryTalk Historian Site Edition page appears. 

5. Click FactoryTalk Historian AF (circled in the previous figure). 
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The Install FactoryTalk Historian Asset Framework window appears. 

6. Click 'Install FactoryTalk Historian Asset Framework Server' (circled in 
the previous figure). 

The Welcome to FactoryTalk Historian Site Edition Asset Framework 
Suite Installation Wizard window appears. 

7. Read the information in the window and click Next. 
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The End-User License Agreement (EULA) appears. 

8. Read the EULA and click 'I accept the terms in the license agreement'.  

The Review Component Installation window appears. 

9. Click Next. 

IMPORTANT The Next button does not become active until you click 'I accept the 
terms in the license agreement'.
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The Destination Drive window appears. 

10. Click Next to install the software to the drive indicated in the window. 
The AF Server Components Configuration window appears. 

11. Click Next.
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The Installation Progress window appears. 

12. Click Install. 

The software installation starts.

After the software has been installed, the release notes are displayed. 

13. Review the Release Notes and close the window when you are finished. 

After you have closed the Release Notes window and the installation is 
complete, the Installation Wizard Complete window opens. 

IMPORTANT The installation cannot be completed until the Release Notes window 
is closed.
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14. Click Finish. 

15. At the FactoryTalk Historian Asset Framework window, click Exit.

Delete Old Computer Name After you have installed the Historian Asset Framework, you need to delete the 
old computer name. Perform the following steps. 

1. Click Start and choose >All Programs>Rockwell Software>
FactoryTalk Historian SE>FactoryTalk Historian SE System>
PISDK Utility. The PI Software Development Kit window opens. 

IMPORTANT At this point, if you are not planning on implementing a 
FactoryTalk Historian SE collective, then go ahead with the steps in this section 
and the Synchronize AF Database section.
If you are planning on implementing a collective, refer to Knowledgebase 
Answer ID 60585 - FactoryTalk Historian SE Collective Manager Error - Error 
Writing Server 
https://rockwellautomation.custhelp.com/app/answers/detail/a_id/60585 
for additional steps to take. This document can also be found in the PlantPAX 
Documentation folder in your template.
You must have a TechConnect license to view this article.
Asset Framework needs to be installed on a separate computer if you have 
implemented a collective. After AF has been installed on a separate computer, 
skip the steps in this section and perform the steps in the MDB to AF 
Synchronization section.

TIP The first time the PI SDK is run, it can take several minutes to complete the 
startup and show a display.
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2. In the explorer pane on the left side of the window, select Connections 
(circled in the previous figure). 

The server pane is displayed in center of the window. 

3. In the server pane, right-click any computer name (other than your 
renamed computer) and choose 'Remove selected Server' (circled in the 
previous figure). 

4. Click Yes.

5. Close the utility.
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Synchronize AF Database 

Once you have the FactoryTalk Historian Asset Framework installed, you need to 
set up synchronization between the Historian server’s module database (MDB) 
and the AF server.

Perform Synchronization

To synchronize MDB to AF, run the MDB to AF Preparation Wizard by clicking 
Start and choosing All Programs>Rockwell Software>FactoryTalk Historian 
SE>MDB to AF Preparation Wizard. 

After successfully completing the MDB to AF Preparation wizard, perform the 
following steps to restart the PI to AF link subsystem service.

1. Click Start and choose All Programs>Rockwell Software>
FactoryTalk Historian SE>System Management Tools.

The System Management Tools dialog box appears.

2. Under Servers, select the Historian Server by checking the checkbox for 
your server.

3. Under System Management Tools, select Operation>PI Services

4. Right-click 'PI AF Link Subsystem (Running)' and click STOP Service.

5. Wait until the service shows 'PI AF Link Subsystem (Stopped)', right-click 
it and select Start Service.

6. Verify that the PI to AF Link Subsystem is running.

IMPORTANT Before proceeding, log off the computer and log in to the computer as the local 
computer Administrator with the password you created 
(see step 9 on page 97).

TIP It can take a few minutes for the wizard to open. Follow the instructions in the 
wizard and complete all four steps.

IMPORTANT The Historian MDB to AF Preparation wizard includes comprehensive online 
documentation. Click Help on any screen in the wizard to get instructions.
See Knowledgebase Answer ID 496679 - FAQ: FactoryTalk Historian SE: MDB to 
AF Preparation Wizard at 
https://rockwellautomation.custhelp.com/app/answers/detail/a_id/496679 
or you can find it in the PlantPAx Documentation folder in your template.
You must have a TechConnect license to view this article.
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Verify Synchronization

Follow these steps to verify the MDB to AF synchronization.

1. If not already displayed, start the System Management Tools by clicking 
Start and choosing All Programs>Rockwell Software>
FactoryTalk Historian SE>System Management Tools. 

The System Management Tools dialog box appears.

2. Under System Management Tools, choose Operation>MDB to AF 
Synchronization.

3. Select the Historian server for which you want to verify the 
synchronization:
• If the synchronization is operating correctly, a green icon appears next 

to the name of the server.
• If synchronization cannot be completed, a red icon appears. Click in 

the System Management Tools dialog box for information on how to 
diagnose and solve the problem. 

IMPORTANT Log off the computer and log on as the new (administrator) user you created 
(see Create an Administrator User Account on page 99).
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Complete Historian 
Configuration

At this point, the FactoryTalk Historian virtual template is ready for use. Review 
the Post Installation Tasks and Configuring FactoryTalk Historian chapters of 
the FactoryTalk Historian SE Installation and Configuration Guide, Rockwell 
Automation Publication HSE-IN025A 
(see http://literature.rockwellautomation.com/idc/groups/literature/
documents/in/hse-in025.pdf ). This document provides a complete list of 
options related to configuring FactoryTalk Historian, adding your Historian to 
the FactoryTalk Directory, assigning license activations to the FactoryTalk 
Historian server, configuration of data interfaces, security configuration, and 
other items to consider to complete your AppServ-Hist installation. 

The FactoryTalk Historian SE Installation and Configuration Guide can be 
found in your template at: c:\AppServ-Hist Software Install Files\
4.00.00-FTHistorian-SE-DVD\Redist\Docs.

IMPORTANT We recommend that you perform the following sections of the FactoryTalk 
Historian SE Installation and Configuration Guide, publication HSE-IN025A, on 
the pages indicated:
• Verify that Historian Services are Running (page 53)
• Verify that Historian Server is Updating Data for Default Tags (page 55)
• Create Security Mappings (page 71)
• Adding the Server to the FactoryTalk Directory Connection (page 78)
• Assigning License Activations to the Historian Server (page 88)
122 Rockwell Automation Publication 9528-UM001D-EN-P - March 2015

http://literature.rockwellautomation.com/idc/groups/literature/documents/in/hse-in025_-en-e.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/hse-in025_-en-e.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/hse-in025_-en-e.pdf


Index

A
account

aministrator password 40, 76, 97
activation

considerations 56, 67, 86
FactoryTalk 89
FactoryTalk software 56, 67, 86, 107
software considerations 56, 67, 86, 107
update search path 68, 87, 108

activation manager
FactoryTalk 68

activation search path
update 69

administrator
account password 40, 76, 97
create user account 42, 78, 99

AF
install

agreement
license 38, 74, 96

AppServ-Hist
FactoryTalk Directory location 106
Microsoft License 8
set speed, duplex settings 105
Windows 2008 R2 SP1 10

AppServ-OWS
FactoryTalk Directory location 85
Microsoft License 8
pre-configured with FTView SE Client 7.0 89
pre-configured with remote desktop server 

role 89
set speed, duplex settings 84
Windows 2008 R2 SP1 10

Asset Framework
see AF

C
clone

virtual machine template 23
computer

delete old name 118
rename 48, 64, 83, 104

configure
AppServ-OWS power management 49, 65, 

84, 105
EWS,OWS virtual machines 59
FactoryTalk Directory on PASS 50
FactoryTalk software activation 56, 67, 86, 

107
PASS 35
RDS 71, 89
virtual image templates 13

considerations
software activation 56, 67, 86, 107

D
datacenter

template 22

definition
open virtual format 7

deploy
OVF template wizard 15
USB drive 13
virtual machines 27

domain
network directory 51
select 48, 65, 84

E
Ethernet

See network adapter
EWS

configure virtual workstation 59
directory location 66
Microsoft License 8
password 63
set speed, duplex settings 65
user name 62
Windows 7 Professional SP1 10

F
FactoryTalk

activation 89
activation manager 68

FactoryTalk Directory
centralized data 35
set AppServ-Hist location 106
set AppServ-OWS location 85
set EWS, OWS location 66

FactoryTalk directory
configuration wizard 50

format
deploy, thick 19, 25, 30
deploy, thin 19, 25, 30
template in VMware 22

I
information hub

FactoryTalk Directory 35
installation, special mode

Remote Desktop Session Host 92
IP address

server 14

L
License

Microsoft on AppServ-Hist 8
Microsoft on AppServ-OWS 8
Microsoft on EWS 8
Microsoft on OWS 8
Microsoft on PASS 8
Windows 7 Professional SP1 8
Windows Server 2008 R2 SP1 8
Rockwell Automation Publication 9528-UM001C-EN-P - March 2014 123



Index
license
agreement 38, 74, 96
RDS 92

location
template 17
virtual machine 28

M
map

network 20
Microsoft

volume 8

N
name

cloned template 23
old computer, delete 118
template 17
virtual machine 28

network
source map 20

O
open virtual format

definition 7
open virtual template

deploy 15
OVF

see open virtual format 7
OWS

configure virtual workstation 59
directory location 66
Microsoft License 8
password 63
set speed, duplex settings 65
user name 62
Windows 7 Professional SP1 10

P
PASS

configuration 35
FactoryTalk Directory configuration 50
Microsoft License 8
Windows 2008 R2 SP1 10

password
server 14

power management
AppServ-OWS 49, 65, 84, 105

R
RDS

Benefits 90
configure 71, 89
known limitations 90
licensing 92
with FactoryTalk View SE 90

Remote Desktop Services
See RDS 89

Remote Desktop Session Host
special installation mode 92

rename
computer 48, 64, 83, 104
SQL server 109
tool, SQL server 110

S
search path

activation, update 68, 87, 108
server

IP address 14
password 14
SQL, rename 109
SQL, rename tool 110
user name 14

settings
set AppServ-Hist speed and duplex 105
set AppServ-OWS speed and duplex 84
set EWS speed and duplex 65
set OWS speed and duplex 65
verify deployment 21

status
cloned template 26, 32

summary
virtual machine details 22

T
template

datacenter 22
location 17
name 17
name clone 23

thick
format, deploy 19, 25, 30

thin
client 89
format, deploy 19, 25, 30

tool
SQL server rename 110

U
USB drive

deploy templates 13
user account

administrator privileges 42, 78, 99
change password 44, 80, 101

user name
server 14

V
verify

deployment setting 21
124 Rockwell Automation Publication 9528-UM001C-EN-P - March 2014



virtual image templates
configuration 13
definition, definition

virtual image templates 13
virtual machine

deployment 27
location 28
name 28
summary details 22
Windows configuration 36, 72, 94

VMware
template format 22

W
Windows

configure virtual machines 36, 72, 94
License 8

Windows 2008 R2 SP1
AppServ-Hist 10
AppServ-OWS 10
PASS 10

Windows 7 Professional SP1
EWS 10
OWS 10

wizard
AF install

workgroup
network directory 51
select 48, 65, 84
Rockwell Automation Publication 9528-UM001C-EN-P - March 2014 125



Index
Notes:
126 Rockwell Automation Publication 9528-UM001C-EN-P - March 2014





Publication 9528-UM001D-EN-P - March 2015
Supersedes Publication 9528-UM001C-EN-P - March 2014 Copyright © 2015 Rockwell Automation, Inc. All rights reserved. Printed in the U.S.A.

Rockwell Automation Support

Rockwell Automation provides technical information on the Web to assist you in using its products.
At http://www.rockwellautomation.com/support you can find technical and application notes, sample code, and links to 
software service packs. You can also visit our Support Center at https://rockwellautomation.custhelp.com/ for software 
updates, support chats and forums, technical information, FAQs, and to sign up for product notification updates.

In addition, we offer multiple support programs for installation, configuration, and troubleshooting. For more 
information, contact your local distributor or Rockwell Automation representative, or visit
http://www.rockwellautomation.com/services/online-phone.

Installation Assistance

If you experience a problem within the first 24 hours of installation, review the information that is contained in this 
manual. You can contact Customer Support for initial help in getting your product up and running.

New Product Satisfaction Return

Rockwell Automation tests all of its products to help ensure that they are fully operational when shipped from the 
manufacturing facility. However, if your product is not functioning and needs to be returned, follow these procedures.

Documentation Feedback 

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this 
document, complete this form, publication RA-DU002, available at http://www.rockwellautomation.com/literature/.

United States or Canada 1.440.646.3434

Outside United States or Canada Use the Worldwide Locator at http://www.rockwellautomation.com/rockwellautomation/support/overview.page, or contact your local 
Rockwell Automation representative.

United States Contact your distributor. You must provide a Customer Support case number (call the phone number above to obtain one) to your 
distributor to complete the return process.

Outside United States Please contact your local Rockwell Automation representative for the return procedure.

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

Rockwell Automation maintains current product environmental information on its website at
http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page.

http://www.rockwellautomation.com/literature/
http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page
http://www.rockwellautomation.com/rockwellautomation/distributor-locator/sales-locator.page
http://www.rockwellautomation.com/support
https://rockwellautomation.custhelp.com/
http://www.rockwellautomation.com/services/online-phone

	Virtual Image Templates User Manual

	Summary of Changes
	New and Updated Information

	Table of Contents
	Preface
	Before You Begin
	Microsoft Software Licensing

	Virtual Template Catalog Numbers
	Rockwell Automation Software License Catalog Numbers
	Build Details
	For More Information

	1 - Configure the Virtual Image Templates
	Deploy a Virtual Image Template for the First Time
	Create a Template on Datacenter for Future Deployments
	Deploy Additional Virtual Machines from Datacenter

	2 - Configure the Process Automation System Server (PASS)
	Before You Begin
	Configure Microsoft Windows Server 2008
	Create an Administrator User Account
	Rename the Computer for Your Location

	Configure Ethernet Network Adapter Settings
	Configure the FactoryTalk Directory on the PASS
	Delete the Old Computer Name

	Configure the FactoryTalk Activation Server
	Open Activation Manager

	Microsoft SQL Server 2008 Express Account Information

	3 - Configure the EWS and OWS System Elements
	Before You Begin
	Configure Microsoft Windows 7 Professional
	Rename the Computer for Your Location

	Configure Ethernet Network Adapter Settings
	Define the FactoryTalk Directory Location
	Configure the FactoryTalk Activation Server
	Open Activation Manager
	Update Activation Search Path

	Microsoft SQL Server 2008 Express Account Information

	4 - Configure Application Server OWS (Microsoft Remote Desktop Services)
	Before You Begin
	Configure Microsoft Windows Server 2008
	Create an Administrator User Account
	Rename the Computer for Your Location

	Configure the Ethernet Network Adapter Settings
	Define the FactoryTalk Directory Location
	Configure the FactoryTalk Activation Server
	Open Activation Manager
	Update Activation Search Path

	Configure Remote Desktop Services
	Remote Desktop Services with FactoryTalk View SE
	PlantPAx AppServ-OWS Base Configuration

	Microsoft Remote Desktop Services Licensing
	Install Additional Software
	Install Special Mode

	Add Remote Desktop Services Users

	5 - 
Configure Application Server Historian
	Before You Begin
	Configure Microsoft Windows Server 2008
	Create an Administrator User Account
	Rename the Computer for Your Location

	Configure the Ethernet Network Adapter Settings
	Define the FactoryTalk Directory Location
	Configure the FactoryTalk Activation Server
	Open Activation Manager
	Update Activation Search Path

	Rename SQL Server
	Install Historian Asset Framework (AF)
	Delete Old Computer Name
	Synchronize AF Database
	Perform Synchronization
	Verify Synchronization

	Complete Historian Configuration

	Index

	Back Cover


